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Tables

Tables are used to present data in the form of rows and columns. A row is a horizontal series
of cells in a table. A column is a vertical series of cells. The intersection of a row and a column
makes a rectangular box called cell. A table is useful in organising and presenting the data in an
effective way. For example, if you want to maintain a student’s record then it is can be stored
using a table effectively.

Activity

Find out and write the telephone number, date of birth and address of any five students of

your class.

S. No. Name Telephone Number Address Date of Birth




A table is a grid of cells arranged in rows and columns. Tables can be used to organize any type
of content, whether you are working with text or numerical data.

Creating a Table

There are three ways to create tables in Word 2010 using the Insert tab. You can also customize
your table using different styles and layouts.

Method 1: Using the Table option
To create a table, follow these steps:

Step 1: Place the insertion point where you want the table to appearin (@l 9 - v |+

the WOfd documeﬁt. Home Insert Pz
. . E C P -

Step 2: Click on Insert tab, then click on the Table command under ; B::; P:z: =1 |l

Tables group. = oage prem || TRHIE | Pture

Pages | Tables
Step 3: This will open a drop-down menu that contains a grid. From  g;o 31, seiecting Tabl

the grid select the number of columns and rows you want.
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Fig 3.2: Selecting rows and columns
Method 2: Using the Insert Table command
To create a table using the Insert Table option, follow the steps:
Step 1: On the Insert tab. In the Tables group, click on the Table drop-down arrow.
Step 2: From the drop-down menu, select the Insert Table option.

Step 3: The Insert Table dialog box appears. Type or select the number of rows and columns
to get the desired table size.

: i R
Step 4: Click the OK. B | e [ e csalizie =]
[B) rewerPage = Ellal Table size
_] mank Fage m - ,:'c)
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zE @ AutoFit to contents
L ® AutoFit to window

Remember dimensions for new tables
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Fig 3.3: Selecting Insert Table option Fig 3.4: Insert Table Dialog Box
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Method 3: Using the Draw Table option IR I
g P e

B @
Table Pictul

[B cover Page ~

To create a table using the Draw Table option, follow these steps: A « ap smapes s
Pages Insert Table ions
. Cli i O0O0O00000
Step 1: Click on the Insert tab. In the Tables group, click on the [EEsEEsss sy
Table drop-down arrow. mEmEm=nEE
: . 10
: mm
Step 2: Click on the Draw Table option. ODoC080000
. . . B msertTable..
Step 3: The cursor turns into a pencil, which you drag down and across o wovrabe
=5 Conyert Text to Table...
to draw a box. Drag the mouse to draw rows and columns. 2 s

Fig 3.5: Selecting Draw Table option
Adding a row or a column

To add a row or a column, follow the steps given below:

Step 1: Place the cursor in the table where you want to add a row or a column. The Layout tab
appears under the Table Tools.

Step 2: Click on the Rows & Columns group under the Layout tab. There are four options available.
=

1) Insert Above .. : This option will insert a row just above the row of the selected cell.

Abova

1) Insert Below o=+ This option will insert a row just below the row of the selected cell.

Insert
Below

€
iif) Insert Left '.n";m' : This option will insert a column just to the left of the column of the

Left

selected cell.

E : This option will insert a column just to the right of the column of the

Right

iv) Insert Right
selected cell.

Step 3: Click on the desired option out of the four options.
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. Vi 25.09.2007 =
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Vi 08.12-2006
Mehak
Vi 23.10.2006
Karan

Fig 3.6: Sclecting a row.

Step 4: A new row or column will be added to the table.
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Fig 3.7: A row inserted above the selected row

Alternatively, you can right-click the table, then move the cursor over Insert to see various

row and column options.
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Fig 3.8: Context menu to insert row/column

Deleting a row or a column

To delete a row or a column, follow the steps given below:

Step 1: Place the insertion point in the row or the column which you want to delete.

Step 2: Right-click, then select Delete Cells from the menu.

Calib!

fiBody) ~[11 - AS A7 EE

BIEW-A-&-[EHF

k]
Name of the Studerf
Ajay i
Y
Mehak
Karan

S0

=

B

Delete Cells...

Date of Birth

25.09.2007

08.12-2006

Insert 23.10.2006

Select
Split Cells...
Borders and Shading...
Text Direction...
Cell Alignment
AutoFit

Table Properties...

Loak Up

Synonyms

Translate

Additional Adtions »

Fig 3.9: Context menu to delete cells
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Step 3: A dialog box will appear. Choose Delete entire row or Delete entire column, then click
on OK.

The row or column will be deleted.

(Deletecels B[]

i shift cells left

Name of the Student Class Date of Birth
() shift cells up
Vi 25.09.2007
@ Delete entire row Ajay
(@ Delete entire column Vi 23.10.2006
Karan

M =
Fig 3.10: Delete Cell dialog box

Table Styles

The tables can be made more attractive and presentable in Word by applying borders, shading,
special fonts and colors to a table by using options available in the Table Styles group. Each style
uses a unique combination of shading and borders to change the appearance of your table.

Fig 3.11: Table after deleting a row

To apply styles to a table, follow the given steps:
Step 1: Click anywhere on the table. The Table Tools appear.

| H9-o = Documentl - Microsoft Word Table Tools, ‘ o B R
Home  Inset  Pagelayout  References  Mailings  Review  View | Design ‘ Layout a @
Header Row First Coumn (4| — —— - - ——  shading ~ - %

otal Row ast Column —-==Z |-/ sorders| - B
[ Total R [ vast col Bord Yapt

—_--- ZTTTT ZZTZTZ-C-T ZTTTT o Draw Eraser
Banded Rows Banded Columns i & PenColor™  Taple

Table Style Options | Table Styles | Draw Borders |

Fig 3.12: Table Styles under Design Tab

Step 2: Under the Table Tools, select the Design tab. In the Table Styles group, select a style
from the drop-down gallery.

| H -3 |= Documentl - Microsoft Word \Table,Tools ‘
File Home Insert Page Layout References Mailings Review View Design Layout

[#] Header Row  [#] First Column Plain Tables ||
] ]
Total Row Last Column EEEEE
@ Banded Rows Banded Caolumns EEEEE
EEE=E
Table Style Options

Built-In

Madify Table Style...

¥1 Clear

8 Mew Table Style...

Fig 3.13: Selecting a Table Style
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The selected style will be applied to the table.

Mameof the Student fass Date of Birth

Mehak Wi 08.12-2006

Karan i 2310,2006

Fig 3.14: Applied Table Style

Mail Merge

Mail Merge is a useful tool that allows you to produce multiple letters, labels, envelopes, name tags
and more using information stored in a list, database or spreadsheet. When performing a Mail
Merge, you will need a Word document (you can start with an existing one or create a new one)
and a recipient list, which is typically an Excel workbook.

Mail merge allows you to create letters, mailing labels and envelopes by linking a main document
to a set of data or data source.

The main document (a document which is to be sent all the recipients) is linked to the data source
by common fields of data, called merged fields.

The data source is a data list that stores data which is different for all mails. The data source
would contain names, addresses, phone number etc. If you were printing envelopes or address
labels, the main document would be the envelopes or the sheet with labels on it; the data source
would be the addresses that are to be placed on these envelopes or labels of sheets. When you are
performing a Mail Merge, you will need a Word document (you can start with an existing one or
create a new one) and a recipient list, which is typically an Excel workbook.

Creating a Mail Merge Document

To create a main document, follow these steps:

Step 1: Open an existing letter in Word document that you want to send to different people or
create a new document and type a letter.

Step 2: From the Mailings tab, click on the Start Mail Merge command and select Step-by-
Step Mail Merge Wizard option from the drop-down menu.

| E ) |= Documentl - Microsoft Word

Home Insert Page Layout References Mailings
Envelopes Labels | [Start Mail Select Edit
Ll

Highlight Address
erge * |Recipients ~ Recipient List | Merge Fields Block

Letters

E-mail Messages

Create

Enyelopes...
Labels...

Directory

@l Mormal Word Document

EObopo

[&]  step by Step Mail Merge Wizard...

Fig 3.15: Mail Merge Wizard
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Step 3: The Mail Merge pane will appears. Now, select Letters radio
button under the Select document type section.

Step 4: Click on Next: Starting document under ‘Step 1 of 6’ section

at the bottom of the task pane.

Step 5: Choose the type of set up for your letters. Click on the Use the
current document radio button under the Select starting document

section.

Step 6: Click the Next: Select recipients under ‘Step 2 of 6’ section.

Creating Recipient List

Mail Merge - x

Select type

Mail Merge v %

Select

What type of document are you
warking on?

@ Letters
© E-mai messages
© Envelopes
© Labels
© Directory
Letters
Send letters to a group of people.
Youcan the letter

Click Next to continue.

Step1ofe

® Next: Starting document

How do you want to setup your
letters?

® Use the aurrent document

@ start from a template

® Start from existing document.
Use the current document

Start from the document shown
here and use the Mai Merge
wizard to add redpient
informaton.

Step2of6
# Next: Select recipients

@ Previous: Select document type

Fig 3.16: Selecting document

Step 1: To create a new mailing list, select the Type a new list radio button under Select
recipients section in the Mail Merge task pane. Click on the Create option.

Step 2: The New Address List dialog box appears on the screen. Click on the Customize
Columns button to add or remove fields.

Step 3: Enter data in the respective fields and click on the New Entry button located at the
bottom-left of the dialog box. Enter any four records of student’s parents. Click on OK.

Mail Merge - x

Select recipients
() Use an existing list

Type recipient information in the table. To add more entries, dick New Entry.

@ Select from Outlook contacts Title

@ Type anew list

Type a new list

Type the names and addresses of
redpients.

E Create...

lerﬁName ledr&asLinH vl[‘.?ry vI

Step 3of 6

Fig 3.17 Creating New Address List

Step 4: You will get the Save Address List dialog. Specify
a name in the File name: text box and click on the Save

button.

Step 5: The Mail Merge Recipients dialog box will appear.
This dialog box displays the details of all the records added

by you.
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Step 6: In case you want to change any detail, you can

your merge. Use the options below to add to or change your list. Use the

select the data source and click on the Edit button | s ime st feres w ok, akot

Data Source First Name w | Title: Address Line 1 w |Cty
located under the Data Source box. When you have |E=Es P A T r—
.. . address 1.m ¥ Mol . R, Model Tow: mal
done the editing, click on OK. sttt |7 Matia Mo UshSeorsy  Notn

Step 7: If you do not want to send the letter to a
particular address, just click on that specific check box

Data Source e

to deselect it. Click on OK. - ome
) 15 End dupicates...
Note that by default tick marks are placed on the 2| Sl
check boxes next to the Data Source field. It gives an | — e C]
indication that the records are selected. “

Fig 3.19: Mail Merge Recipients dialog box
Step 8: Now, click on the Next: Write your letter under Step 3 of 6 section in the Mail Merge
task pane.

Inserting Merge Fields

Step 1: Place the cursor at the position where you want to insert the record fields.

Step 2: On the Mailings tab, click on the Insert Merge Field button under the Write & Insert
Fields group.

Step 3: The Insert Merge Field dialog box appears with a list of field names that has been
created by you.

Step 4: Click on the field name that you want to add and then ey e REES

L s b . @ Rules =
click on the Insert button. _ =21 |33 Match Fields
Highlight Address Greeting [Insert Merge|
L. A . . Merge Fields Block  Line Field ~ patelabel:
Similarly, insert other fields into the document. Click on the write &1 Te ]
Close button. First Name
Address_Line_1
The selected field names will appear in your document one after il
the another at the place where you wanted to insert it. Fig 3.20: Selecting a field

; |
5 <<First_MName>>

Insert: ‘

|

z¢Address Line_1z»
) Address Fields @ Database Fields _ = "
Figlds: <<City>>

- Dear <<Title>»<<First Names>

Address Line 1
City

This is to invite you to the Annual Children Mela at The Maontessori Schoal on
Friday, 7th August, 2018 at 10:00-am to 1:00 pm. We'll have many fund-raising
activities. Puppet-show, magic-shiow, food stalls, theatrical performanices,
solving-the-puzzle and other outdoor games.

You are highly encouraged to attend this event with your kids. The funds’
collected from all the abeove activities will go to a charitable organization for
specidl children who deserve monetary care. This event will be highty
beneficial in strengthening parent-child relationship.

-

MatchFields.. | [ mnsert | [ coneel |

Fig 3.21: Inserting Merge Field Fig 3.22: Merged document
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Viewing the Merged Data

Preview the letters to make sure the information from the recipient list appears correctly in the
letter. You can use the left and right scroll arrows to view each version of the document.

Step 1: When you are done, click Next: Preview your letters | ¥ & i
% . . Ep Rules -
to move to Step 5 or you can click on the Preview Results B8 s e Fieas ‘

Wlight Address Greeting Insert Merge

button in the Preview Results group on the Mailings tab.  :fieds siocc tine  fiela- [ Update Labels

‘Write & Insert Fields

Step 2: The first record will be displayed. Click on Next Fig 3.23: Clicking on Preview Results
Record button in the Preview Results group to view the next record of the data source.

Results

Step 3: If everything looks correct, click on Next: Complete the merge to move to Step 0.

“alirgs

||'-|L.?E1’ BI:DJZ”'""

£

Emrlopcs Loz 't:l’tMII Sclet |Q"II!'|' Accrlss r<|'|=:rac1M<l'=
R M,....,'u..,

Linte St Ml Vi

Frerea
[ Lpome Laasls | esre
o e s |

Sumit

F10/4, Malviya Nagar,
Delhi

Lkzar Mr. Sumit
oo e do mretile you Lo the Arnasl Chekdnem Kiade o The Mos oo Schaol on

#ner o nzuc ot vritng
Fribws., 798 Agna, 200 Bt DO avoin 3530 i W e rroewy end raking wea bl b b e

il tcn:rnn.mc-n =

redics Pappeldhom, maga-dhae, feod alb, sl sofosmanies
f auterg-the-pude end othar oetdoor gamas

Perud AT Mgl o 0O uraged 0l R L Ens el WATH o ek, The Tamks
cofkectad fram all the aboros acinitien wilipa a3 choriiabie crpanicsson e
apewLa chibdren whe decsus marerry ree, Thic seerr adl be bighly
weredoal B SHETEite eI Sarerr -l relienglas,

Z; stepdafh
a| W Mexterreecveiettes
i

o Provien: Sl e 5

4 [ L

Jaoeasti, donaz, |a56.]

Fig 3.24: Previewing letter

Printing the Letters
Step 1: Click on Print to print the letters.

Step 2: A dialog box will appear. Decide if you want to print all of the letters, the current
document (record), or only a select group, then click on OK.

Step 3: The Print dialog box will appear. Adjust the print settings if needed, then click on OK.
The letters will be printed.

=0 [meS
Printer
Name: % Send To OneNote 2010 Properties
Type: Send To Microsoft OneNote 2010 Driver ————
Where: nul: Print to file
Comment: Manual duplex
Page range Copies
@ All Mumber of copies: I
) Current page ) Selection
@ Pages: 7 collate
Type page numbers andfor page
ranges separated by commas counting
from the start of the document or the
section. For example, type 1, 3, 5-12
or pisl, pis2, p1s3-—p8s3
Print: All pages in range ! Pages per sfieet: !
Scale to paper size: |No Scaling !
(o J( el ]

Fig 3.25: Printing letters
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= USING TABLES AND
= MAIL MERGE

EXERCISE

A. Tick (V) the correct answer.

1. Information such as name, address, contact number of the person is known as

\/cv)’Dcﬁa source b) Main document c) Letter
2. needs to be created for mailing or sending letters to various people.
\;ef)/Recipien'r list b) Main document c) Letter
3. The intersection of a row and a column is called
a) Border \,b‘)/CeII c) Table
4. Tables group is present under the tab.
a) Layout b) Home \;j’rnser'r
5. To create a New Recipients List, select the radio button under the
Select recipients section.
\/eﬂzl'ype a new list b) Use an existing list c) Select from contact
B. Fill in the blanks.
1. Mail Merge helps in creating single and multiple letters, labels, envelopes, name tags.
2. The main document is linked to the data source by common fields of data, called merge fields.
3. The Insert tab is used to create tables in MS Word.
4. Rows and columns group is present under Layout tab.
5. The Preview Results option on Mailings tab displays the first record from the data source.

Write True (T) or False (F).

A row is a horizontal series of cells in a table.

You can insert column only to the left side of the selected column.
Main document is a part of Mail Merge.

Data source contains mailing list.

The data source would be the addresses that are to be placed on Main Document.

Using Mail Merge we cannot create letters.
Short answer type questions.

Explain the term table.

> " Do uhxwN =0

A table is used to present data in the form of rows and columns. It is useful in organising
and presenting the data in an effective way.



L
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What is data source?

The data source is a data list that stores data which is different for all mails. It can have
names, address, phone number, etc.

What is Mail Merge?
Mail Merge is a useful tool that allows to produce multiple letters, labels, envelopes, etc.

Long answer type questions.
How can you make a table more attractive using the Table Styles option?

The recipient list is a data list that stores data which is different for all mails. For
example,it can contain names, addresses, phone number etc. of the people to whom the
letter or the mail is to be sent.

Write the steps which you will follow for starting Mail Merge.

Step 1: Open an existing letter in Word document that you want to send to different
people or create a new document and type a letter.

Step 2: From the Mailings tab, click the Start Mail Merge command and select Step-by-
Step Mail Merge Wizard option from the drop-down menu.

Step 3: The Mail Merge pane will appear. Now select Letters radio button under Select
document type section.

Step 4: Click on Next: Starting document under ‘Step 1 of 6’ section at the bottom of the
task pane.

Step 5: Choose the type of set up for your letters. Click on Use the current document
radio button under the Select starting document section.

Step 6: Click the Next: Select recipients under ‘Step 2 of 6’ section.
What is the use of recipient list2

The tables can be made more attractive and presentable in Word by applying borders,
shading, special fonts and colors to a table by using options available in the Table Styles
group. Each style uses a unique combination of shading and borders to change the
appearance of a table.

Application based questions.

. Janvi has created a table of her weekly study schedule. By mistake she forgot to add

Wednesday schedule in the table. Which feature will she use to add the row/column
for Wednesday?

She can use the Layout tab > Rows & Columns group. Different options Insert Above/
Insert Below / Insert Left / Insert Right can be used.

Suhana has created a birthday invitation for sending it to her 50 friends through Email.
But some of her friends are not using email so she has to take a print out for them. How
can she take out the print out using the MS Word’s feature for those who do not have
Email id2

Using Mail Merge feature.

Aditi wants to call her staff for an emergency meeting. Which feature of MS Word will
she use to save time and energy?

Mail Merge
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ASSIGNMENT- 4
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CLASS-6
SUBJECT- ENGLISH

BOOK PRESCRIBED- ORIENT BLACKSWAN-GULMOHAR 9™ EDITION

TEACHER- SUGANDHA BANERIJEE

CONTENT- Literature- Chapter 2- Wild Duck

The following study material is given below:-

The pdf of the chapter is given separately.

The summary of the chapter.

The video link of the chapter is- https://youtu.be/On9S GwdHJO
The answers of the exercises.
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INSTRUCTIONS FOR STUDENTS

Go through the text of the chapter.
Go through the summary of the chapter.

Click the video link to see the chapter in animated form.
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Go through the answers given.

WORK TO BE DONE IN THE COPY

Note:- All the written work to be done in the English Literature Register Copy

neatly.

Following work is to be done in the English copy:-

1) Pick out 20 difficult words from the chapter and write them three times in
your literature copies.

2) Write the word meanings given in the chapter neatly.


https://youtu.be/On9S_GwdHJ0

3) Make sentences with the following words- seeped, billowed, buckshot,
plummeted, wheeling, bulrushes

4) Do the following exercises in your copies-

Understanding the text- A. Complete these sentences
B. Answer these questions

Appreciating the text- 1 and 2

Grammar and usage- A and B

Words in use- A and B
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Summary

Wild Duck

A young boy goes duck-hunting with his father for the first time.
His father is unsuccessful but the son bags a bird with his very
first shot. The father is delighted at the boy’s aim but the boy is
horrified at what he has done. To his relief, he finds that the
duck is alive. But it is grievously injured—itswing is permanently
damaged and so the boy nurses it back to health. Some time
after this incident, the father asks his son about the

gun’s whereabouts only to discover that the boy had thrown the
weapon away, because it disgusted him. At first the father is angry
and horrified at his son’s disobedience and his sentiments towards
hunting. But he then realises that it was for the best.

‘Wild Duck’ is an adaptation from a full-length story. This
sensitively written story traces a father-son relationship and
a ‘coming of age’ experience. The transition from teenage
years to adulthood can be a testing time and the writer has
portrayed this struggle in this story.The father seems to be
testing his son and watching to see how the boy



reacts. The son’s bold decision to break free from his father’s
shadow forms a significant moment in the story.

Answers

CLASS-6 LITERATURE CHAPTER- 2- WLID DUCK (ANSWERS)

Understanding the Text

A.1l. ...he loved birds and enjoyed watching them.
2. ...he had hunted before and knew very well how the birds would behave.

3. ...he felt guilty for having shot and wounded it and felt responsible for its sorry
state.

4. ...the boy taught the man how to show compassion to all living beings.

B. 1. The boy showed interest in what they were doing only when the birds
arrived because he was fascinated by birds and enjoyed observing them. Bird-
watching was his passion.

2. Here, the birds are beginning to fly across the lake and are arriving in flocks.
They have arrived in such large numbers that it is as if they have blotted out the
light from the sun. The reflections of these numerous birds have been cast upon
the water giving it a dark colour as well. (Suggested answer. Accept any logical
answer.)

3. The boy had fired at the duck, which fell into the water. When the boy picked
it up, the duck’s limp body made him believe that it was dead—the thought that
he had taken another creature’s life frightened him.

4. No, the man did not want the boy to look after the duck. We know this
because the manner in which he said this indicated that he wanted to stop the
boy from looking after the duck by implying that it was a big responsibility. To
this, the boy responded that he wanted to go home, indicating that he was sure



that he wanted to take on this responsibility. It was also a message to his father
that he did not agree with the idea of hunting. When his father persisted with his
guestion hoping to change his mind, the boy replied firmly, showing us that he
was not willing to do so. The boy’s reaction surprised his father who, until now,
did not realise that his son felt differently about hunting.

5. a. The boy was bold enough to make a decision that went against his father
and then, tell his father the truth about what he had done. This tells us that at
that point, the boy was sure about his principles and felt brave enough to go
against his father.

b. Free response

6. The father’s reaction changed from anger to relief because he now understood
that the gun represented violence against a living creature. With the gun gone, he
would no longer be able to hurt or harm another animal. He also realised that this
incident made him look at animals with compassion and thus was relieved that
the gun was gone.

Appreciating the Text

1. a.i. The boy experiences a sense of conflict in his mind when he shoots the
duck. We know that he loves birds but he takes part in hunting one. This conflict
becomes more obvious just after he shoots it and then decides to look for it.

ii. The man feels a sense of conflict when the boy tells him that he has thrown the
gun away. At first, the man is angry but this anger changes to remorse at the
thought of what the gun has done. This remorse then turns into relief. Thus, the
man finds himself torn between these feelings.

b. This conflict occurs when the boy reveals that he has thrown away the gun,
thus angering the man. He is unable to understand why the boy dislikes the gun
so much because to him, the gun is something that helped the boy get close to
the bird he greatly admired; he is unable to see it as something that wounded and
maimed the duck.

Words in Use

A. 1. Billowed



2. spellbound
3. passion

4. whistled

5. horizon

6. maimed

7. lopsided

8. backyard
9. stretch

10. flap

B. 1. When you sit in a bullock cart, you find that you are always rocking from side
to side.

2. There were no people, no houses, no roads. It was a wilderness.
3. He scores goals because his footwork is dead-on.

4. We were looking down at the city, but the aeroplane banked one way and we
could only see the sky. 5. They put the screen right in front of us, blotting the
entire ground.

6. The big drops of rain made little ripples in the water
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Jagat Taran Golden Jubilee School
Class 7
Subject- Mathematics
Assignment-4
Read Chapter 5 : Lines and Angles
Link for the chapter=>

https://diksha.gov.in/play/content/do 3129911222980689921201

link for the video=>

https://diksha.gov.in/play/content/do 31290683094402662413264?referrer=utm source%3Ddiksha m
obile%26utm content%3Ddo 31304485372202188815108%26utm campaign%3Dshare content

Do in your maths copy ;

e Write important definitions and draw(Line segment, ray, angle, complementary angles,
supplementary angle, adjacent angles, linear pair, vertically opposite angles ,intersecting lines
and point of intersection ,transversal ,parallel lines ) .

Link for 2 video =>

https://diksha.gov.in/play/content/do 31274791695056076814813referrer=utm_source%3Dd
iksha mobile%26utm content%3Ddo 31274791695056076814813%26utm campaign%3Dshar
e _content

e Do questions from Exercise 5.1

e Ifalineis atransversal to two lines draw the 8 angles formed and write their special names.

e Write the conditions that will result ,if two parallel lines are cut by a transversal ,also draw the
figure .
Link for 3 video=>
https://diksha.gov.in/play/content/do 31274791698214912014815referrer=utm_source%3Dd
iksha _mobile%26utm content%3Ddo 31274791698214912014815%26utm campaign%3Dshar
e_content

e Do questions from Exercise 5.2.


https://diksha.gov.in/play/content/do_3129911222980689921201
https://diksha.gov.in/play/content/do_31290683094402662413264?referrer=utm_source%3Ddiksha_m%20obile%26utm_content%3Ddo_31304485372202188815108%26utm_campaign%3Dshare_content%20%20
https://diksha.gov.in/play/content/do_31290683094402662413264?referrer=utm_source%3Ddiksha_m%20obile%26utm_content%3Ddo_31304485372202188815108%26utm_campaign%3Dshare_content%20%20
https://diksha.gov.in/play/content/do_31274791695056076814813?referrer=utm_source%3Ddiksha_mobile%26utm_content%3Ddo_31274791695056076814813%26utm_campaign%3Dshare_content
https://diksha.gov.in/play/content/do_31274791695056076814813?referrer=utm_source%3Ddiksha_mobile%26utm_content%3Ddo_31274791695056076814813%26utm_campaign%3Dshare_content
https://diksha.gov.in/play/content/do_31274791695056076814813?referrer=utm_source%3Ddiksha_mobile%26utm_content%3Ddo_31274791695056076814813%26utm_campaign%3Dshare_content
https://diksha.gov.in/play/content/do_31274791698214912014815?referrer=utm_source%3Ddiksha_mobile%26utm_content%3Ddo_31274791698214912014815%26utm_campaign%3Dshare_content
https://diksha.gov.in/play/content/do_31274791698214912014815?referrer=utm_source%3Ddiksha_mobile%26utm_content%3Ddo_31274791698214912014815%26utm_campaign%3Dshare_content
https://diksha.gov.in/play/content/do_31274791698214912014815?referrer=utm_source%3Ddiksha_mobile%26utm_content%3Ddo_31274791698214912014815%26utm_campaign%3Dshare_content
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1. fo e argeii & Sfew wdi & fraa wEl @ ofy @t
(Fill in the blanks with suitable forms of the given roots.)

@) FF T —— ()
(@) T FEGF e (o)
(D) omar g sl o (T
(@) S FHET =)
() TR | e -
() FEFT ) )
2. feu Tyt @ fae vt @t ufit &0 (Fill in the blanks with the given words.)

3. Wt fawew g1 (Choose the corree
(F) & A Wi (=) 397
(@) T3 R (vvaia/vvay




() ¥ W (=i restgy TealE) |
(&) a9 oy (wmrefa/ ares Eery ) |
() S & (7 /7979 /=01(H) |

4. Freafafes ageat @ a=m s1d) (Make sentences with the following verbs.)
A, "Efg, «ifh, ey, fawata

5. Frafefea are=i & fraeii = @ &

(Correct the verbs in the following sentences.)

(F) = for forafa? () & THY: |

(&) 39 syat A4~ (T) & W A

() 11"{] gy frafig | =) TS e Fef
6. FrfefEa arel &1 sigeng &4 (Translate the following sentences.)

@ ¥ T s R

(@) ﬁ?ﬁ‘*[:fﬂ?q_m?“n (=) me

am WBIH fassm (71) "?:ﬂ“:ﬂ ATAT TIW"

7. @Ha o argare & (Translate into Sanskrit.)
(%) ® @ @I gl (Iam playing.)
(@) v 241 | T 211 (Both of you are speaking.)
(77 ®H 99 O &7 2@ ® €1 (All of us are watching the peacock.)
() gH g s 811 (You are a well-behaved boy.)
(@) ¥ ufior @2 ® €| (Those deer are running.)
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Sorting Materials into Groups

4.1 OBJEcTs AROUND US

We have seen that our food and clothes
have so much variety in them. Not just
food and clothes, there is such a vast
variety of objects everywhere. We see
around us, a chair, a bullock cart, a
cycle, cooking utensils, books, clothes,
toys, water, stones and many other
objects. All these objects have different
shapes, colours and uses (Fig. 4.1).
Look around and identify objects
that are round in shape., Our list may
include a rubber ball, a football and a
glass marble. If we include objects that
are nearly round, our list could also
include objects like apples, oranges, and
an earthen pitcher (gharha). Suppose

Fig. 4.1 Objects around us

we were looking for objects that are
edible. We might include all the items
that we have listed in Tables 1.1, 1.2
and 1.3 in Chapter 1. We might also
find that some of those round shaped
objects we just listed out, are also in
this group.

Let us say, we wish to make agroup
of objects that are made of plastics.
Buckets, lunch boxes, toys, water
containers, pipes and many such
objects, may find a place in this group.
There are so many ways to group objects!
In the above examples we have grouped
objects on the basis of their shape or the
materials they are made from.

All objects around us are made of one
or more materials. These materials may
be glass, metal, plastics, wood, cotton,
paper, mud or soil. Can you think of
more examples of materials?

Activity 1

Let us collect as many objects as
possible, from around us. Each of us
could get some everyday objects from
home and we could also collect some
objects from the classroom or from
outside the school. What will we have
in  our collection? Chalk, pencil,
notebook, rubber, duster, a hammaer,
nail, soap, spoke of a wheel, bat,
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matchbox, salt, potato. We can also list
objects that we can think of, but, cannot
bring to the classroom. For example,
wall, trees, doors, tractor, road.

Separate all objects from this
collection that are made {rom paper or
wood. This way we have divided all objects
into two groups. One group has the
objects that are made from paper or wood
while the other group has the objects
that are not made of these materials.
Similarly, we could separate the things
that are used for preparing food.

Let us be a little more systematic. List
all objects collected, in Table 4.1, Try to
identify the materials that each one is
made of. It would be fun to make this a
large table — collecting information
about as many objects as possible. It
may seem difficult to find out the
materials out of which some of these
objects are made. In such cases, discuss
with your friends, teacher and parents
to identify the materials.

Table 4.1 Objects and the materials
they are madeof

Materials they are

Objects adelot

Steel, glass, plastics

Plate (thali) (any other)

Pen Plastics, metal

Activity 2

Table 4.2 lists some common materials.

You can also add more materials in
w0RTING DLEATERIALS INTO \GROUFS
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. ! we found some materials that
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‘Boojho wants to know, whether

were used for making more th:
one type of an object.

Column 1 that are known to you. Now,
try and think of everyday objects you
know, that are made mainly of these
materials, and list them in Column 2.

Table 4.2 Different types of objects
that are made from the same

material
A Objects made of
Material these materials
Chair, table,
Wood plough, bullock cart
and its wheels, ..,
Books, notebooks,
Paper newspaper, toys,
calendars,...
Leather
Plastics
Cotton

What do we find from these tables?
First, we grouped objects in many
different ways. We then found that
objects around us are made of different
materials, At times, an object is made of
a single material. An object could also
be made of many materials. And then
again, one material could be used for
making many different objects, What
decides which material should be used

——a!

h

Scanned with CamScanner



for making any given object? It seems
that we need to know more about
different materials.

4.2 PROPERTIES OF MATERIALS

Have you ever wondered why a tumbler
is not made with a piece of cloth? Recall
our experiments with pieces of cloth in
Chapter 3 and also keep in mind that
we generally use a tumbler to keep a
liquid. Therefore, would it not be silly,
if we were to make a tumbler out of cloth
(Fig 4.2)! What we need for a tumbler is
glass, plastics, metal or other such
material that will hold water. Similarly,
it would not be wise to use paper-like
materials for cooking vessels.

Fig. 4.2 Using a cloth tumbler

We see then, that we choose a
material to make an object depending
on its properties, and the purpose for
which the object is to be used.

So, what are all the properties of
materials that would be important for
their usage? Some properties are
discussed here.

28
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Appearance

Materials usually look different from
each other. Wood looks very different
from iron. Iron appears different from
copper or aluminium. At the same time,
there may be some similarities between
iron, copper and aluminium that are not
there in wood.

Activity 3

Collect small pieces of different materials —
paper, cardboard, wood, copper wire,
aluminium sheet, chalk. Do any of these
appear shiny? Separate the shiny
materials into a group.

Now, observe as the teacher cuts each
material into two pieces and look at the
freshly cut surface (Fig. 4.3). What do
you notice? Does the freshly cut surface
of some of these materials appear shiny?
Include these objects also in the group
of shiny materials.

Do you notice such a shine or lustre
in the other materials, cut them anyway
as you can? Repeat this in the class with
as many materials as possible and make
a list of those with and without lustre.
Instead of cutting, you can rub the
surface of material with sand paper to
see if it haslustre.

Wy,

Fig. 4.3 Cutting pieces of materials to see if they
have lustre

Science
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Materials that have such lustre are
usually metals. Iron, copper, aluminium
and gold are examples of metals. Some
metals often lose their shine and
appear dull, because of the action of air
and moisture on them. We therefore,
notice the lustre, only on their freshly
cut surface. When you visit an
ironsmith or a workshop, look out for
freshly cut surfaces of metal rods to see
if they have lustre.

Hardness

When you press different materials with
your hands, some of them may be hard
to compress while others can be easily
compressed. Take a metal key and try
to scratch with it, the surface of a piece
of wood, aluminium, a piece of stone, a
nail, candle, chalk, any other material
or object. You can easily scratch some
materials, while some cannot be
scratched so easily. Materials which can
be compressed or scratched easily are
called soft while some other materials
which are difficult to compress are called
hard. For example, cotton or sponge is
soft while iron is hard.

In appearance, materials can have
different properties, like lustre,
hardness, be rough or smooth, Can you
think of other properties that describe
the appearance of amaterial?

Soluble or Insoluble?
Activity 4

Collect samples of some solid substances
such as sugar, salt, chalk powder, sand
and sawdust. Take five glasses or

SorTing MaTERIALS INTO GROUPS
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beakers. Fill each one of them about two-
thirds with water. Add a small amount
(spoonful) of sugar to the first glass,
salt to the second and similarly, add
small amounts of the other substances
into the other glasses. Stir the contents
of each of them with a spoon. Wait for a
few minutes. Observe what happens to
the substances added to water (Fig. 4.4).
Note your observations as shown
in Table 4.3.

/r‘ ._;-- """‘ _'h-“:“-‘;.\l

Fig. 4.4 What disappears, what doesn’t?

Table 4.3 Mixing different solid
materials in water

Substance Ddizil;l!:::sdi:a;::g:l
Salt ggstaeepems completely in
Sugar

Sand

Chalk

powder

Sawdust

You will notice that some substances
have completely disappeared or
dissolved in water. We say that these
substances are soluble in water. Other
substances do not mix with water and
do not disappear even after we stir for a

29
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long time. These substances are
insoluble in water.

Water plays an important role inthe
functioning of our body because it can
dissolve a large number of substances.
Do liquids also dissolve in water?

Activity 5

Collect samples of vinegar, lemon juice,
mustard oil or coconut oil, kerosene or
any other liquid. Take a glass tumbler,
Fill it up to half with water. Add a few |
spoonfuls of one liquid to this and stir |
it well. Let it stand for five minutes.
Observe whether the liquid mixes with
water (Fig. 4.5). Repeat the same with
other liquids, as many different liquids
as are available to you. Write your
observations in Table 4.4,

Table 4.4 Solubility of some
common liguids in water

Mixes well/

Liquid Does not mix

Vinegar Mixes well

Lemon juice

Mustard oil

Coconut oil

Kerosene

(b)

Fig. 4.5 (a) Some liquids mix well with
water while (b) some others do not
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We notice that some liquids get
completely mixed with water. Some
others do not mix with water and form
a separate layer when kept aside for
some time.

p—

- ;
/ Boojho suggests that we

used in Activity S5, mix well with
some liquid other than water.

Paheli is curious to know
whether gases also dissolve
in water.

Some gases are soluble in water
whereas others are not. Water, usually,
has small quantities of some gases
dissolved in it. For example, oxygen gas
dissolved in water is very important for
the survival of animals and plants that
live in water.

Objects may float or sink in
water

While doing Activity 4, you might have
noticed that the insoluble solids
separated out from water. You may have
also noticed this with some liquids in
Activity 5. Some of these materialsthat
did not mix with water, floated to the
surface of water, Others may have sunk
to the bottom of the tumbler, right? We
notice many examples of objects that
float in water or sink (Fig. 4.6). Dried
leaves fallen on the surface of a pond, a
stone that you throw into this pond, few

Science
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Figure 4.6 Some objects float in water while
others sink init
drops of honey that you let fall into a
glass of water., What happens to all
of these?

Boojho would like you to give him
five examples each, of objects that float
and those that sink in water, What
about testing these same materials to
see if they float or sink in other liquids
like 0il?

Transparency

You might have played the game of hide
and seek. Think of some places where
you would like to hide so that you are
not seen by others. Why did you choose
those places? Would you have tried to

Fig. 4.7 Looking through opaque, transparent or
transhucent material

Sorting MATERIALS INTO GROUPS
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hide behind a glass window? Obviously
not, as your friends can see through that
and spot you. Can you see through all
the materials? Those substances or
materials, through which things can be
seen, are called transparent (Fig, 4.7).
Glass, water, air and some plastics are
examples of transparent materials.
Shopkeepers usually prefer to keep
biscuits, sweets and other eatables in
transparent containers of glass or

Fig. 4.8 Transparent botiles in a shop

plastic, so that buyers can easily see
these items (Fig. 4.8).

On the other hand, there are some
materials through which you are not
able to see. These materials are called
opaque. You cannot tell what is kept
in a closed wooden box, a cardboard
carton or a metal container. Wood,
cardboard and metals, are examples of
opaque materials.

Do we find that we can group all
materials and objects, without any
confusion, as either opaque or
transparent?

Activity 6

Take a sheet of paper and look through
it towards a lighted bulb. Make a note
of your observation. Now, put 2-3 drops

31
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of some oil and spread it on the sheet of
paper. Look again towards the lighted
bulb through that portion of the paper
on which the oil has been spread. Do
you find that the bulb is more clearly
visible than before? But, can you sece
clearly through the oiled paper? Is
everything on the other side of it visible?
Perhaps not. The materials through
which objects can be seen, but not
clearly, are known as translucent.
Remember the oily patch on paper when
we tested food items for presence of fats?
That was translucent too. Can you
think of some more examples of
translucent materials?

We can therefore group materials as
opaque, transparent and translucent.

Paheli suggests
covering the glass
of a torch with your
palm at a dark
place. Switch on

the torch and
observe the other

Fig. 4.9 Does torch
light pass through
your paim?

side of the palm.
She wants to know

Key words

Hard
Insoluble Rough
Lustre Soluble
Material Translucent
Metals Transparent
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whether palm of your hand is opaque,
transparent or translucent?

We learnt that materials differ in their
appearance and the way they mix in
water or other liquids. They may float
or sink in water or may be transparent,
opaque or translucent. Materials can be
grouped on the basis of similarities or
differences in their properties.

Why do we need to group materials?
In everyday life, we often group materials
for our convenience. At home, we
usually store things in such a manner
that similar objects are placed together.
Such an arrangement helps us to locate
them easily. Similarly, a grocer usually
keeps all type of biscuits at one corner
of his shop, all soaps at another while
grains and pulses are stored at some
ather place.

There is another reason why we find
such grouping wuseful. Dividing
materials in groups makes it convenient
to study their propertiesand also
observe any patternsin these properties.
We will study more about this in
higher classes.
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a > that an obj
-many different types of materials.
Different types of materials have different properties.

Some materials are shiny in appearance while others are not. Some are
rough, some smooth. Similarly, some materials are hard, whereas some
| others are soft,

|+ Some materials are soluble in water whereas some others are insoluble.

Some materials such as glass, are transparent and some others such
as wood and metals are opaque. Some materials are translucent.

~ Materials are grouped together on the basis of similarities and differences
in their properties.

= Things are grouped together for convenience and to study their
properties.

— Ex__erl:isesﬁ

1. Name five objects which can be made from wood.

= = ==

2. Select those objects from the following which shine:
Glass bowl, plastic toy, steel spoon, cotton shirt

3. Match the objects given below with the materials from which they could be
made. Remember, an object could be made from more than one material and a
given material could be used for making many objects.

Objects Materials
Book Glass
Tumbler Wood
Chair Paper
Taoy Leather
Shoes Plastics

4. State whether the statements given below are True or False.
(i) Stone is transparent, while glass is opaque.
(ii) A notebook has lustre while eraser does not,
(idi) Chalk dissolves in water.

(iv) A piece of woad floats on water,

Sorting MATERIALS InTO GROUPS -
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(v) Sugar does not dissolve in water.
[vi) Oil mixes withwater.
(vii) Sand settles down in water.

(viii)  Vinegar dissolves in water.

aglasem.cam
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Given below are the names of some objects and materials:
Water, basket ball, orange, sugar, globe, apple and earthen
pitcher Group them as:

(a) Round shaped and other shapes

(b) Eatables and non eatables

6. Listallitems known to you that float on water. Check and see if they will float
on an oil or kerosene.

7. Find the odd one out from the following:
a) Chair, Bed, Table, Baby, Cupboard
b) Rose, Jasmine, Boat, Marigold, Lotus
¢) Aluminium, Iron, Copper, Silver, Sand

d) Sugar, Salt, Sand, Copper sulphate

SUGGESTED ACTIVITY

You may have plaved a memory game with your friends. Several objects are
placed on a table, you are asked to observe them for a few minutes, go into
another room and write down the names of all objects that you can remember.
Play this game, with a difference! Ask all the participants in the game to
remember objects with some particular property while playing thismemory
game — remember and write down the names of objects that were made of
wood or objects that are edible and so on. Have fun!

From a large collection of materials, make groups of objects having different
properties like transparency, solubility in water and other properties. In later
chapters you will also learn about properties of materials related to electricity
and magnetism. After making different groups from the collected materials,
try and find out if there are any patterns in these groups. For instance, do all
materials which have lustre conduct electricity?

Science
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NCERT Solutions for Class 6 Science
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Simplifying Test Prep

NCERT Solutions
Class 6 Science
Chapter 4 - Sorting Materials into Groups

1. Name five objects which can be made
from wood. Answer.

Five objects which can be made from wood are:

(i) Table

(i) Chair

(iii) Almirah

(iv) Bed

(v) Door

2. Select those objects from the following which shine:
Glass bowl, plastic toy, steel spoon,

cotton shirt Answer.

Things which shine are: Glass bowl and steel spoon.

3. Match the objects given below with the materials from which they could
be made. Remember, an object could be made from more than one
material and a given material could be used for making many objects.

Object [Materials
Book Glass
Tumbler Wood
Chair Paper

Toy Leather
Shoes Plastics
Answer,

Object Materials
Book Paper
Tumbler Glass
Chair Wood

Toy Plastics
Shoes Leather

4, State whether the statements given below are ‘true’ or ‘false’.
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(i) Stone is transparent, while glass is opaque.

(i) A notebook has lustre while eraser does not
(iii) Chalk dissolves in water.

(iv) A piece of wood floats on water.

(v) Sugar does not dissolve in water.

(vi) Oil mixes with water.

(vii) Sand settles down in water.

(viii) Vinegar dissolves in water.

Answer.
(i) False; Stone is opaque, while glass is transparent.

(i) False; Neither notebook nor eraser has lustre (Shining surface). They both are non-
lustrous.

(iii) False; Chalk is inscluble in water.

(iv) True

(v) False; Sugar is completely soluble in water.

(vi) False; Oil is immiscible in water. It forms a separate layer on the surface of water.
(vii) True

(viii) True

5. Given below are the names of some objects and materials:

Water, basket ball, orange, sugar, globe, apple and earthen pitcher Group them as:
(a) Round shaped and other shapes

(b) Eatables and non-

eatables Answer.

Given objects are grouped as follows:

(a) Round shaped and other shapes:

Round Other
shaped shapes
Basket ball Wate
Orang r

e suga
Globe L
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Apple
Earthen

(b) Eatables and non-eatables:

Eatable| Non-eatables

s
Water | Basket
Orang | Ball

€ Globe

Sugar | Earthen
Apple | Pitcher

6. List all the items known to you that float on water. Check and see if they
will float on an oil or kerosene.

Answer.

List of some items that float on water:
» Piece of paper

s Wood

s Balloon

¢ Plastic bottle
s Ice

= Boat

List of items that float on an oil or kerosene:
¢ Piece of paper
s Plastic bottle
« Balloon
« Wood

7. Find the odd one out from the following:
(a) Chair, Bed, Table, Baby, Cupboard

(b) Rose, Jasmine, Boat, Marigold, Lotus

(c) Aluminium, Iron, Copper, Silver, Sand

(d) Sugar, Salt, Sand, Copper

sulphate Answer.

(a) Baby (As rest of them are non-living things)
(b) Boat (As rest of them are flowers)

(c) Sand (As rest of them are metals)

(d) Sand (As rest of them soluble in water)
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Subject- Social Science (HISTORY)

Chapter- 2
WHAT,WHERE,HOW AND WHEN.
Publication- Prachi (India) Pvt. Ltd.

STUDY MATERIAL
Dear Parents/Students

Kindly follow these instructions:-

Tap on Chapter link(y
https://youtu.be/3SYmQwflosl

For explanation.


https://youtu.be/3SYmQwfJosI

Watch the video related to the chapter of
HISTORY Lesson- 2 and try to comprehend.

Complete the given assignment in your History
Notebook.

ASSIGNMENT-4
Chapter 2: WHAT, WHERE, HOW and WHEN

a)Define the following terms-
1) Archaeology. 2) Inscription
3) Historian. 4) Manuscript

5) Numismatics
b) Write why these dates are important.
i) 8000 years ago. i) 4700 years ago

iii) 2500 years ago

Answer the following questions:-



Q1) Differentiate between Manuscript and
inscriptions.

Q2) Why do people travel nowadays ?Give
reasons.

Q3) What are the main functions of
archaeologist?

Activities-

1 Read the chapter and find out the subjects on
which books were written in the past. What
kind of books would you prefer to read ?

2.Suppose you are an archaeologist You have
found many objects while digging a site .Write

a story using the objects found.






T

For example, time difference between 500 BC and
AD 1,500 = 500 years + 1,500 years = 2,000 years.

BP

Sometimes, BP i.c., Before Present is also used
to denote past events.

For the convenience of the study, we assume
2,000 AD/CE as present age.

In India, we began to use these terms about
200 years ago with the influence of the Britishers.
Earlier we calculated dates according to Vikram
Samvat.

THE GEOGRAPHICAL FRAMEWORK

The history of a place is influenced greatly by
its geography. The geographical factors determine
the development of a particular area. The areas
where the environment is favourable, are densely

populated. Their culture is also affected by outside
influences or forcign travellers. On the other hand,
the places with an unfavourable environment are
sparsely populated. The culture that develops here
is not much affected by outside influences.

The history of the Indian subcontinent has

: largely been influenced by its geography.

Do Vou Know ?
What is Indian subcontinent ?
South Asia is often called a subcontinent which
includes the present countries of India, Pakistan,
Bangladesh, Nepal, Bhutan and Sri Lanka. It
is called so because although it is smaller a
continent, yet it is very large and separated from
the rest of Asia by seas, hills and mountains.
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WHERE DID PEOPLE LIVE ?
On the basis of the analysis of
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the Geographical framework of our
subcontinent, we can easily understand
that early people lived mainly in the
following places.

Banks of Narmada

The area traces the habitation of
the earliest people of the subcontinent.
For several thousand years people lived
along the banks of river Narmada. They
were skilled gatherers i.e., gatherers of
food. They collected roots, fruits and
many other forest produce for food.
The vast wealth of the plants scattered
around in the surrounding forest areas,
was very well-known to them.

They also hunted animals for food
and used their skins for making clothes.

The Areas along the Sulaiman and
Kirthar Hills

These areas are located to the
northwest of the subcontinent. These
are some of the places where people
first started growing crops like wheat

it
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